
 

Using GRSeo ‐ Search Engine Optimizer™ 
 

1. The actual process of optimization begins with choosing your best keyword phrases. 

Here are some suggestions to consider. If you have already selected your keywords, skip to step #2. 

The real truth? It is not really about ranking -- it's about increasing traffic to your Web 
site. Web site traffic is about having the right set of keywords and keyword phrases. 
Using free available webmaster tools on the web you can easily find what are the 
keywords that user search for. Select the ones that score best in order to drive more 
traffic to your site. 

 

Please start by reading these articles. The articles are titled Choosing the Right 
Keywords and Ten Suggestions for Getting Your Site Listed. They are located at 
http://www.grsoftware.net/home/articles.html 

2. Launch GRSeo. 

The program features are broken into four tabbed sections: Project, Options, Checker Elements 
and Report.  

Project section: define project names, keywords and HTML files to evaluate.  

Options section: select program defaults and options. 

Checker Elements section: Search Engine choice and the list of checks performed. 

Report section: display of GRSeo analysis results. 

3. Select the Options tab. 

This dialog allows you to personalize the program defaults. Here you can enable/disable options and 
define the editing tools to use from inside GRSeo to manage your project files.  

There are three sections under the Options tab: Select Your Preferred Tools To Launch Within 
The Program, Analysis and Miscellaneous. 

The Select Your Preferred Tools To Launch Within The Program section allows you to specify 
your own file editing programs -- a Browser (e.g. Firefox or MSIE or Opera), HTML Editor 
(e.g.,GoLive, Dreamweaver), Text Editor (e.g., Notepad, NoteTabPro) and two user defined tools. 
Select the Browse button to easily choose your preferred editing applications. 

Note: To access these editing applications, right click on the HTML file item you want to 
edit in the Files to Check section under the Project tab or right click on a Report dialog 
item (or press the Menu button in the Report dialog). 

Analysis allows you to define some of the options of the analysis phase. The "Do not consider the 
final 's' of any word while matching keywords" option instructs GRSeo to disregard the final 's' on any 
words while analyzing your files. This makes plural keywords equivalent to singular keywords. This 
option is helpful when working with major search engines that today consider plurals to be 
synonymous to singular words. For those engines, do mark this box. 

The Skip words whose length is less than N option instructs GRSeo to skip words shorter than the 
specified number of characters while analyzing your files. This allows you to drop the shorter words 
like: of, the, an, and, etc. In this program, skip words are similar to stop words, which are words that 
the engines won't stop for when performing searches. 

http://www.grsoftware.net/home/articles.html


Miscellaneous includes some general program options. Enable Tooltips will display short comment 
messages when you move your cursor over an option. We suggest you have this option enabled 
while learning the program. Autosize report dialog columns instructs GRSeo to automatically resize 
the report column widths, which will make your reports more compact and easier to read. 

4. Select the Project tab. 

This dialog allows you to define your projects, your keywords specific to the project, and to select 
specific files to check for optimization.  

In the upper left corner, you will see the word default in the window. This is where you will list and 
choose Project Names for your Web sites. Click New and type in the name of your first Web site 
project (for our example, we named our project GRSoftware because we will use the 
www.grsoftware.net.net Web site for an example evaluation). In addition to creating new projects, 
you have options to Delete and to Edit your Project Names. 

The next line down is the Project Folder field. Click the >> button to the right of this field and select 
the folder on your hard drive that contains the html files for this project. Hint: keep your HTML file 
folders at higher levels in your hard drive so your Project Folder isn't so long you can't see it all in the 
field size provided. 

The Keyword/Phrase section on the upper right is where you will enter your keywords and keyword 
phrases to evaluate for this project. You have options to Add, Delete, Edit and Empty List. There is 
no limit to the number of keywords/phrases you may enter in this field. However, you can select only 
one keyword/phrase at a time for analysis. Hint: only one keyword phrase should be the primary 
target per page.  Two or three other keyword phrases can be added but they will always be 
secondary keywords for the page.  

The Files to Check section is where you add the files to evaluate and optimize. Press the Add 
button to add a file.  
 
Notice the check box next to the file name. This enables you to select specific files to analyze for 
particular keywords/phrases. The files must be located in your local hard disk drive in the Project 
Folder defined previously. This means that if your files are stored in your web site then you must 
download them first. 
 
You can easily import your html files from the WEB by pressing the Import button. Other options are: 
Delete files, Empty List, Uncheck all boxes and Check all boxes for evaluation at one time.  
 
The program will automatically save all the settings in the currently selected project so you will not 
need to worry about this. 

5. Select the Checker Elements tab. 

This section of the program has two functions. 
 
1. You select in the top left field the Search Engine you want to target for your evaluation. Hint: You 
can select the Search Engine also from the Report tab. 
 
2. It allows you to see in the large field on the left, all of the Controls executed when the program 
runs.  When you highlight one of the elements, on the right there will appear text in gray that shows 
you what are the Short Messages you will see when the program actually runs. It also shows you the 
Detailed Descriptions you see when you double click on the Short Message in the Report section 
after you click Start.  
 
Note: you do not use this section for the evaluation of each file.  This information is what the 
program draws upon to give you your information.  It is also where we will make the changes each 
month in order to keep the program settings well aligned with the supported search engines. 



Now, select the first search engine to evaluate from the drop down list in the tope left corner, then 
press the Start button at the bottom of the window. GRSeo will analyze your selected project files 
and will automatically display the Report dialog so you can watch the report generate. 

6. The Report tab. 

This dialog displays GRSeo analysis results, including the Search Engine and Keyword/Phrase 
analyzed, a Menu of action items, a HTML Report option and a detailed report in the large field.  

If you have chosen to evaluate several files at once, there is a little symbol at the left that looks like a 
pin on a sheet and there is a black bar then across the screen to divide the files.  

From the Menu button, you can select various actions. These Menu items can also be accessed by 
right clicking on the report screen. The following action items available from the Menu: 

· Show Item Details: This action will expand the short Description of recommendations to a more 
specific Detailed Description of what to consider when optimizing your page. 

· Export Report as Text and Export Report as HTML  

· Copy to Clipboard as Text and Copy to Clipboard as HTML 

· Email Report as Text 

The Html Report button will show you in a Browser, the report you see in the program 

On the Report screen there are three columns: Importance, File Name and Description. 

Importance column has three possible indicators: 

· Suggestion (yellow graphic and field): Advises there is something you should consider when 
optimizing your file. Remember that these suggestions are alerts for something you should 
consider.  Not everything suggested must be followed.  You must use judgment in whether to do 
something or not.  

· Warning (red graphic and white field): Warns there is definitely something you need to do for 
optimization. This is more serious and should be followed more fully. 

· Error (red graphic and red field): Means you must change your file as indicated by the Detailed 
Description. Here, you just do it! 

File Name column is the name of the file in need of optimization. 

Description column is a short description of what to pay attention to. For a detailed description, you 
can do any of the following: 

· Double click on the actual description line. 

· Right click on the description line and choose Show Item Details. 

· Click on the Menu button and choose the Show Item Details. 

The detailed description dialog will display the complete information. You can resize the dialog in 
order to easily see all the details. The new user defined size will be saved by the program so that 
the next time you will open this dialog will will automatically resize to the last used size. 

Note: You can manually resize the report columns or select the Autosize report dialog columns 
option in the Options section to have the columns auto sized for good readability. You can also 
resize the whole program, making it larger so you can read all the information. 

7. Optimizing Your Files. 

You may want to export or print the report to a text or HTML file to make it easier to review as you 
start to optimize your site.  



To begin the optimization of a file, evaluate the report line by line by double clicking, right clicking or 
using the Menu button to read the Detailed Description. Then launch your file editor and change your 
file as suggested by GRSeo. 

Note: Access your file editor by right clicking your mouse or by using the "F" key equivalents 
(Select File Open [F2] to select your browser, File Edit [F3] to select your HTML editor, or Edit as 
Text to [F4] use your text editor).  

You can now go line by line and make all the recommended changes. Once satisfied, save your file, 
and click the Start button to re-analyze the file. Or you may want to click the Start button after each 
change to make sure the report reflects your change and has had the desired effect. 

Note also that there are special suggestions for each search engine at the end of each section set of 
results. These are important to read through and consider. 

We suggest that you do this process line by line and start another report after each change so you 
will become proficient with the program and the optimization adjustments. In time, you may want to 
do more lines at a time before you start the checker again. 

8. Updating your GRSeo.chk file. 

Each month we will email the login user name and password you need to download your GRSeo.chk 
file update if your yearly subscription is still active, so do not forget to renew your subscription in 
time. 
 
Inside the program, you can easily update your file GRSeo.chk by going to the Project dialog and 
pressing the Download Check File button.  
 
The program will then ask you your login user name and password. Cut and past them from our 
email message to this dialog and then press the OK button.  
 
At this point a download dialog will appear reporting you the download progress. When the download 
is completed then press the Close button.  
 
You can verify that the downloaded file is new by checking the Check file was updated on: line. It 
should be today's date. If something goes wrong during download, you can see any error reported on 
the download dialog in the line Status. 

8. Checking your Ranking. 

Periodically analyzing the ranking in the search engines for each of your optimized pages is an 
essential part of making sure your driving the best possible traffic to your site.  Check to make sure 
your pages are in the top 10 search results for each of your targeted keywords. We recommend 
Ranking-Manager Tools as the most effective programs for checking your positioning. This is an 
essential tool for your optimization strategy.  
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